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Software License 

The Centracs™ SOFTWARE and its documentation are protected by copyright laws and international 

copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE is licensed, not 

sold. 

This Centracs Software License Agreement grants you the following rights: 

 You may install and use the Centracs Core, Device Manager, Communications and other Server 

components of the SOFTWARE on computers located on City/Agency premises communicating 

with the maximum number of field devices set by the license key included with the SOFTWARE. 

 You may install and use the Centracs Client/Workstation SOFTWARE on any number of 

workstations located on the premises of City/Agency or agency partners/consultants.  The Centracs 

Client/Workstation SOFTWARE may only be used with the City/Agency Centracs system.  Use of 

the Centracs Client/Workstation SOFTWARE with other City/Agency Centracs systems is expressly 

prohibited. 

 You may not reverse engineer, decompile, or disassemble the SOFTWARE, except and only to the 

extent that such activity is expressly permitted by applicable law, notwithstanding this limitation.  

 You may not sell, lease, license, sublicense, distribute or otherwise transfer in whole or in part the 

SOFTWARE or any parts thereof to another party. 

Without prejudice to any other rights, Econolite may terminate this Software License if you fail to comply 

with the terms and conditions of the License Agreement. In such event, you must destroy all copies of the 

SOFTWARE and all of its component parts. 

 

Warranty 

Econolite warrants that the media, if any, on which the SOFTWARE is delivered and documentation 

supplied is free from defects in material and workmanship under normal use and service and that the 

SOFTWARE will substantially conform to the description contained in the documentation for a period of 

one-year beginning upon completion of acceptance testing of the SOFTWARE.  In the event of notification 

within the warranty period of defects in material or workmanship, or if the SOFTWARE does not 

substantially conform to the description contained in the documentation, ECONOLITE, at its sole option, 

will repair or replace the defective media or documentation or correct the defects in the SOFTWARE. The 

foregoing is the only warranty of any kind expressed or implied. There are no implied warranties of 

merchantability and fitness for a particular purpose. In no event shall ECONOLITE, or its suppliers be liable 

for any damages whatsoever (including, without limitation, damages for loss of property, injury, life, 

business profits, business interruption, loss of information, or other pecuniary loss) arising out of the use of 

or inability to use this SOFTWARE. 

Econolite agrees to provide City/Agency with one year of technical support via phone or email for the 

SOFTWARE beginning upon completion of acceptance testing of the SOFTWARE. This technical support 

will cover all SOFTWARE components provided by Econolite. SOFTWARE components provided by 

others, (including any and all area maps and intersection graphics) will not be included in this technical 

support. 
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Copyright Notices 

Under the copyright laws of the United States of America, the Centracs SOFTWARE, or this 'User Manual', 

MAY NOT be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine-

readable form, in whole or part, without prior written permission from Econolite. The SOFTWARE is 

developed and marketed by Econolite in part under a license of certain copyrighted works of others as to 

certain elements and in part as the copyrighted work of Econolite. ECONOLITE also has or may have 

patents, patent applications, and owns all associated trademarks, copyrights, or other intellectual property 

rights covering subject matter in this document. Except as expressly provided in a written license agreement 

from ECONOLITE, the furnishing of this notice does not give any entity or individual (the user) any license 

to the patents, trademarks, copyrights, or other intellectual property. The United States Code, Title 17, 

protects the Software and this Document (the Copyright Act). ANY SUCH ACTIVITY OR PRODUCT 

BECOMES THE ABSOLUTE PROPERTY OF THE COPYRIGHT HOLDER.  

 

Restricted Rights Legend 

Any SOFTWARE which is provided for or on behalf of the United States of America or for or on behalf of 

Licensee, their agencies and/or instrumentalities ("U.S. Government") is provided with Restricted Rights. 

Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in Federal 

Acquisition Regulations subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer SOFTWARE 

clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer SOFTWARE - 

Restricted Rights at 48 CFR 52.227-19, as applicable. The manufacturer is Econolite, 3360 E. La Palma Ave, 

Anaheim, CA 92806, (714) 630-3700. ANY RIGHTS NOT EXPRESSLY GRANTED HEREIN ARE 

RESERVED. 

 

Trademark 

Microsoft XP, Microsoft Vista, Windows Server 2003, Windows Server 2008, Microsoft SQL Server 2005, 

and Microsoft SQL Server 2008 are either a registered trademark or trademark of Microsoft Corporation in 

the United States and/or other countries. Oasis, ASC/3, ASC/2 and Centracs are products with trademarks or 

registered trademarks owned by Econolite Control Products, Inc. W4IKS, W7OSM and W9FT are products 

of Wapiti Microsystems Inc. 
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Preface 

Centracs™ is a true client-server application. The server side maintains the database, performs device 

communications, performs periodic functions, etc. The client is the component that provides the user 

interface. Centracs can be set up with all components on a single computer or can be distributed across 

several separate servers and multiple client workstations. The client-to-server communication is very 

efficient, even across a wide-area network. 

The software installation procedures in this manual are given in separate chapters: 

1. Centracs Core Server Install 

2. Centracs NTCIP Communication Server Install 

3. Centracs NTCIP Client Workstation Install 

Prerequisites 

To install and uninstall software, you must be logged into Windows® with administrative privileges or with 

the correct permissions set. If necessary, contact your IT/IS department. 

Before setup, make sure that Microsoft® .NET Framework 3.5 Service Pack 1 is installed1. 

 

Notes 

 If all Microsoft updates have already been installed, then Microsoft .NET Framework 3.5 SP1 is 

included. 

 To download and install Microsoft .NET Framework 3.5 SP1, you must have an Internet connection. 

 

More Information about Centracs 

For more information, call or email Econolite Technical Support: 

800-225-6480 / support@econolite.com 

Our website: www.econolite.com 

To access the Econolite Technical Support website, go to 

http://techsupport.econolite.com/  and register. 

 

                                                   

1
 If you were to start the setup without Microsoft .NET Framework 3.5 SP1 installed, the InstallShield

®
: 

1. Would attempt to download it from Microsoft. 

2. After the download, would require a restart of the workstation before it continued with the Centracs install. 

mailto:support@econolite.com
http://www.econolite.com/
http://techsupport.econolite.com/
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11..  CCeennttrraaccss  CCoorree  SSeerrvveerr  IInnssttaallll  

Start 

1. Insert Centracs Installation CD into the workstation CD-ROM Drive or locate the Centracs install 

directory on the server and copy over to local workstation. 

2. Location: <Centracs_Server>\!\Installed\Centracs 1.3.x.xxxx - xxxxxx xxxx 

3. In DiskImages\DISK1\ double click on “Centracs 1.3.x.xxxx - xxxxxx xxxx.exe.” 

4. This will start the Centracs InstallShield® Wizard that will install Centracs on your computer. 

5. To continue, click  Next> . 
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License Agreement 

 

 

6. To read the rest of the agreement, press  Page Down . 

7. To continue to install Centracs, click  Yes . 
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Destination Folder 

 

 

8. Select the destination folder to install Centracs: 

 To install in the default folder 

C:\Program Files\Econolite\Centracs\, 

click  Next > . 

 To install in a different folder, click  Browse . . .  , select that folder, then click  Next > . 
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Select Features 

 

 

9. As shown in the screen on the subsequent page: 

 Deselect: 

□ Centracs Client Workstation  

□ Communications Server Applications 

 Select: 

 Centracs Main Server  

 Database Server Applications  

 Centracs Map Server  
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10. Next to “Database Server Applications,” click  + . 
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11. Make sure that “Reports” is selected, as shown above. 

12. Click  Next> . 
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Database Server Login 

 

 

13. Under “Connection Name:” in the field “Database server that you are installing to,” browse to or 

enter the name of the SQL Server 2008 instance. 

14. Click on the radio button for “SQL Server authentication using Login ID and password below.” 

 Make sure the “Login ID” is correct. 

 Enter the “Password.” 

15. For “Name of database catalog,” leave the field blank. 

16. Click  Next> . 
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Start Installation 

 

 

17. Click on the applicable button: 

 To review or change the installation settings, click  <Back . 

 To start the installation, click  Install . 

 To exit the wizard, click  Cancel . 
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Restart Computer to Initialize Files 

 

 

18. Click on the applicable radio button: 

 Yes, I want to restart my computer now. 

-or- 

 No, I will restart my computer later (necessary for system files to correctly initialize). 

19. Click  Finish . 
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22..  CCeennttrraaccss  NNTTCCIIPP  CCoommmmuunniiccaattiioonn  SSeerrvveerr  IInnssttaallll  

Start 

1. Insert Centracs Installation CD into the workstation CD-ROM Drive or locate the Centracs install 

directory on the server and copy over to local workstation. 

2. Location: <Centracs_Server>\!\Installed\Centracs 1.x.x.xxxx - xxxxxx xxxx 

3. In DiskImages\DISK1\ double click on “Centracs 1.x.x.xxxx - xxxxxx xxxx.exe.” 

4. This will start the Centracs InstallShield® Wizard that will install Centracs on your computer. 

5. To continue, click  Next> . 
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License Agreement 

 

 

6. To read the rest of the agreement, press  Page Down . 

7. To continue to install Centracs, click  Yes . 
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Destination Folder 

 

 

8. Select the destination folder to install Centracs: 

 To install in the default folder 

C:\Program Files\Econolite\Centracs\, 

click  Next > . 

 To install in a different folder, click  Browse . . . , select that folder, then click  Next > . 
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Select Features 

 

 

9. As shown in the screen on the subsequent page: 

 Deselect: 

□ Centracs Client Workstation  

□ Centracs Main Server  

□ Database Server Applications  

□ Centracs Map Server  

 Select: 

 Communications Server Applications 
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10. Next to “Communications Server Applications,” click  + . 
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11. As shown in the screen above: 

 Select: 

 Communications Servers 

 NTCIP Device Manger 

 Deselect: 

□ ACT Device Manager 

 

12. Click  Next> . 
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Start Installation 

 

 

13. Click on the applicable button: 

 To review or change the installation settings, click  <Back . 

 To start the installation, click  Install . 

 To exit the wizard, click  Cancel . 
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Restart Computer to Initialize Files 

 

 

14. Click on the applicable radio button: 

 Yes, I want to restart my computer now. 

-or- 

 No, I will restart my computer later (necessary for system files to correctly initialize). 

15. Click  Finish . 
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33..  CCeennttrraaccss  NNTTCCIIPP  CClliieenntt  WWoorrkkssttaattiioonn  IInnssttaallll  

 

Start 

1. Insert Centracs Installation CD into the workstation CD-ROM Drive or locate the Centracs install 

directory on the server and copy over to local workstation. 

2. Location: <Centracs_Server>\!\Installed\Centracs 1.x.x.xxxx - xxxxxx xxxx 

3. In DiskImages\DISK1\ double click on “Centracs 1.x.x.xxxx - xxxxxx xxxx.exe.” 

4. This will start the Centracs InstallShield® Wizard that will install Centracs on your computer. 

5. To continue, click  Next> . 
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License Agreement 

 

 

6. To read the rest of the agreement, press  Page Down . 

7. To continue to install Centracs, click  Yes . 
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Destination Folder 

 

 

8. Select the destination folder to install Centracs: 

 To install in the default folder 

C:\Program Files\Econolite\Centracs\, 

click  Next > . 

 To install in a different folder, click  Browse . . .  , select that folder, then click  Next > . 
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Select Features 

 

 

9. As shown in the screen on the subsequent page: 

 Select: 

 Centracs Client Workstation  

 Deselect: 

□ Centracs Main Server  

□ Communications Server Applications 

□ Database Server Applications  

□ Centracs Map Server  
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10. Next to “Centracs Client Workstation,” click  + . 
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11. As shown in the screen on the subsequent page: 

 Deselect: 

□ W4 and Oasis Editors 

□ Eagle EPAC Editor 

 Select: 

 ASC/2 and ASC/3 Editors 

 

12. Click  Next> . 
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Start Installation 

 

 

13. Click on the applicable button: 

 To review or change the installation settings, click  <Back . 

 To start the installation, click  Install . 

 To exit the wizard, click  Cancel . 
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Restart Computer to Initialize Files 

 

 

14. Click on the applicable radio button: 

 Yes, I want to restart my computer now. 

-or- 

 No, I will restart my computer later (necessary for system files to correctly initialize). 

 

15. Click  Finish . 
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Show File Extensions 

To show file extensions: 

1. Go to Windows Explorer. 

2. Click Tools > Folder Options… 

 

3. Click the “View” tab: 

4. Deselect “Hide extensions for known types.” 

5. Click  OK . 
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Configure Centracs.exe.config 

 

 

1. Browse to “C:\Program Files\Econolite\Centracs\CentracsClient” 

2. Right click on “Centracs.exe.config” 

3. Open with Notepad. 

4. Locate “300” in “<value>300</value>” as shown below. 
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5. Change to “3000” as shown below. 

 

 

 

6. Locate “<string>localhost:81</string>” 

7. Change to “<string>Your_Core_Server_Name_or_IP_Address:81</string>” 

8. Click File > Save 

9. Close “Centracs.exe.config” 

10. Close Windows Explorer. 
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Run Centracs 

1. On the Desktop, double click on the Centracs shortcut,    

 

 

 

 

2. Enter User Name. 

3. Enter Password. 

4. Click  Log In . 

 

Notes 

 When Centracs Core Server updates have been installed, Centracs Client Workstation will 

automatically update from the Centracs Core Server.  

 After login, Centracs Client Workstation compares its version with the version of the Centracs 

Core Server. If the versions are not the same, the server gives you the option to update: 

 If you select “Yes,” the latest version of Centracs is transferred to the Centracs Client 

Workstation and installed. 

 If you select “No,” the Centracs Client Workstation software will not connect to the 

Centracs Core Server until you accept to install the update capability. 

 

 


